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IMPORTANT PRODUCT INFORMATION

 READ THIS INFORMATION FIRST
Product: Control Version 2.30 Service Pack 1 Programmer and Configurator

IC641CTL970M Control 90-70 Programmer w/CD Documentation

IC641CTL971M Control 90-70 Programmer w/paper Documentation

IC641CTL170M Control 90-70 Programmer Logicmaster 90 upgrade

IC641CTL171M Control 90-70 Programmer Subscription upgrade

IC641CTL930K Control 90-30 Programmer w/CD Documentation

IC641CTL931K Control 90-30 Programmer w/paper Documentation

IC641CTL130K Control 90-30 Programmer Logicmaster 90 upgrade

IC641CTL990K Professional Developer Package 90-70, 90-30, SFC

IC641CTL993M OEM Evaluation Kit – 30-day license

IC641CTL972K Upgrade to add 90-70 target

IC641CTL932K Upgrade to add 90-30 high-end target

IC641CTL937D Programmer Toolkit

IC641CUG970M Control 90-70 Programmer Upgrade

IC641CUG930M Control 90-30 Programmer Upgrade

IC641CUG990L Professional Developer Package 90-70, 90-30, SFC Upgrade

Control Version 2.30 provides configuration and programming support for GE Fanuc Series 90-30 (Models 350 and
higher), Series 90-70, and VersaMax (Model CPU001) controllers. Control runs under Microsoft® Windows® 95,
Windows 98, Windows NT® 4.0, and Windows 2000. Built on the latest Microsoft technology, Control is designed to
adhere to industry standards including Microsoft Foundation Classes (MFC) 6.0, ODBC 3.5, and OLE 2.3, making
Control easy to use and integrate with other applications.

Control Version 2.30 fixes several problems and introduces several new features.  Control Version 2.30 Service Pack 1
also fixes several problems.  Refer to the New Features (page 11) and Problems Resolved (page 13) sections in this
document for detailed information.

Special Operational Notes

1. Copy/Paste of Operands in Ladder Logic
Control Version 2.2 contains a problem where copying and pasting operands in the Ladder Logic Editor while online
and equal does not cause the Editor to go not equal.  The problem can arise in the following manner.  Insert an ADD
(or any other function/function block) instruction in the Ladder Logic Editor.  Put %R00001 on IN1, the constant 1 on
IN2, and %R00001 on Q.  Store the program to the PLC and place the PLC in RUN mode.  Select %R00001 on IN1
and press <Ctrl>C or select Copy from the Editor’s Edit menu to copy the operand to the Windows clipboard.  Select
the constant 1 on IN2 and press <Ctrl>V or select Paste from the Editor’s Edit menu to paste the operand’s data.  Save
the logic and Compile.  Rather than going to a Not Equal state, the status bar of the Ladder Logic Editor shows Equal.
If you then try to Store or Verify logic with the PLC, you will be told all items are equal even though they are not.
This problem has been corrected in Control Version 2.3.
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2. Addresses in Indexed Named Alias Variables
Control Version 2.2 contains a problem where an indexed, named alias variable has a different address in the Ladder
Logic Editor than it does in the Variable Declaration Editor.  The problem can arise in the following manner.  Define
a base variable called BaseVar1 with an address of %I00001, type of BOOL, and a length of 15.  Define a named alias
of the first variable called DefinedVar1 with an address of BaseVar1[3], type of BOOL, and length of 6.  Drop a
contact in the Ladder Logic editor and use DefinedVar1[6] on it.  Turning on the option to show both address and
name in the Ladder Logic Editor will show that the contact has an address of %I00013.  However, expanding the same
variable in the Variable Declaration Editor will show the variable at the offset used in logic has an address of
%I00008.  If you toggle the contact in Ladder Logic, %I00013 will be turned on in the PLC.  If you toggle the variable
at the offset used in the Variable Declaration Editor, %I00008 will be turned on in the PLC.  This problem has been
corrected in Control Version 2.3.

3. Execution Change
The Execution problem described below was fixed in Control Version 2.2.  If you were using these instructions as
described below, your execution may change when rebuilding this type of rung with Control Version 2.2 or higher.

Incorrect operation of 90-70 or 90-30  logic for optional boolean flow input parameter on SHFTL and SHFTR.

The behavior for these instructions when the optional boolean input parameter was left blank was inconsistent with
LM90 and incorrect.  The correct behavior is to default the optional boolean parameter to FALSE when it is left
blank; whereas, in previous releases of Control, this parameter defaulted to TRUE in some cases.

4. Retentive Attributes for Variables
Logicmaster did not have retentive attributes for variables.  Control has retentive attributes for variables and
instructions.  The error checking to insure these match has been increased.  Old folders may see error messages on
retentive states.  Two actions can be used to resolve these errors.

a) Correct the retentive states.

b) An option has been added to make the error a warning.  This option is at the equipment folder level.

5. System Requirements

a) Control is compatible with Windows 95, Windows 98, and Windows NT 4.0 (through service pack 5), and
Windows 2000.

b) Your system must meet the following minimum requirements* to successfully install and run Control for
Windows 95, Windows 98, Windows NT, and Windows 2000.  If free hard drive space requirements are not
maintained, Control and the underlying operating system may not operate correctly.

For Windows 95 and Windows 98 For Windows NT and Windows 2000
System Features Minimum Recommended Minimum Recommended

CPU Pentium/60 Pentium/133 Pentium/75 Pentium/133
RAM 32 MB 64 MB 48 MB 96 MB
Free Hard Disk Space* 75 MB 75 MB 100 MB 100 MB
CD-ROM Drive Yes Yes Yes Yes

*Save As function.  Premature termination of the product may occur if you attempt a “Save As” function to a disk that
has insufficient space.  To avoid losing work, be sure your disk has the recommended space available.  Control will not
allow a “save as” to any storage device that has less than 5 megabytes of free space.

                                                       
* These requirements are for Control running as a single application. Memory requirements to run applications
simultaneously are additive. Acceptable performance is subjective and can be enhanced by employing more RAM
memory and faster processors as they become available.
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6. Folder Compatibility
Version 2.30 of Control automatically upgrades the folder storage to a new version from the version used in previous
releases.  This new folder storage version is not backward compatible, so that after opening a folder with Version 2.30,
the folder can no longer be opened by earlier releases.

7. Speed Disk
Speed Disk (a defragmentation utility included in Symantec's Norton Utilities package) is configured to move the
Control license system files.  The Control license files (wb.ent, wb.key, wb.rst, and wb.41s) are hidden system files
which reside under the installed product directory.  When Speed Disk moves these files, the Control license is
disabled.

To prevent this problem, open Speed Disk and use File|Options|Optimization|Customize|Unmovable Files to specify
the *.ENT, *.KEY, and *.RST files.  Use File|Options|Optimization|Save to save your changes.  This will prevent the
Control license files from being moved.

Other defrag utilities may exhibit the same behavior as Speed Disk and should be checked for excluding these files
before running them.

8. Communications
Storing block and configuration information in the same attempt through 90-30 Serial Port #2 may fail.  This
has been observed on a 351 CPU, storing program and configuration information, and seems to happen whether or not
the new configuration information is actually different or not.

Instances of HDRVSNP.EXE may be left in memory during operation of Control.  There are some scenarios in
which instances of HDRVSNP.EXE may be left in memory after Control stops executing.  There may also be times
when Control causes multiple instances of HDRVSNP.EXE to be loaded into memory.  When either of these scenarios
occur, Control may fail to connect to the PLC or may exhibit strange behavior during communications.  If this
behavior is observed, close Control and bring up the Windows Task Manager.  Select the “Processes” tab and sort the
list by “Image Name”.  Search the list for HDRVSNP.EXE.  Select an occurrence of this process and press the “End
Process” button.  Do this for each instance of HDRVSNP.EXE shown in the list.  Once these processes have been
terminated, communications in Control will proceed as normal.

9. LD Editor
Numerical Instructions on the LD fly out toolbar had no selections.  If the Numerical Instruction Toolbar does not
fly out (has no selections), it means that the CPU which is configured does not support Variables of type REAL. The
CPU type needs to be changed to one that supports REALs and all LD Editors need to be closed then reopened to have
Numerical Instructions work.

10. Installation
To install Control, insert the CD-ROM into the CD-ROM drive. To view the contents of the CD-ROM, click the drive
letter configured for your CD-ROM, (typically D:\ ) from Explorer. Double-click the icon beside setup.exe. Review the
following notes for technical information about Control installation:

• Once you accept the software license agreement, you will be asked to select the product you wish to install.
Choose to install the “Control System” instead of the “Control Demo.”

• If you are installing on a computer that has dual boot into Windows 95 or Windows NT, you should un-install
and then install on one operating system, then boot into the other operating system, repeating the procedure.

• In addition to program files, Control installs Microsoft support files in the Windows system directory. If these
files exist, they will be replaced only if Control requires a later version than the one currently installed.
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• If you attempt the installation when other Windows applications are open, you may see messages saying the
install has attempted to update a read-only file. Answer NO to the prompt asking whether to update the file.
You should exit the Install program (ALT+F3 ), close all Windows applications and restart the Control
installation program. If the message persists, reboot your machine and repeat the process.

• Control uses the GEF_CFG.INI file that is placed in the Windows root directory to record communications
device configurations. This file is also used by CIMPLICITY HMI and Motion, as well as other applications
developed with the Host Communications Toolkit for communicating with GE Fanuc PLCs.  If the file
already exists, a prompt will display asking if the file should be overwritten. . If you overwrite the file, you
may lose configuration information used by software programs that access GE Fanuc PLCs.

• To keep your existing GEF_CFG.INI file, select NO.  The new default file will be placed in GEF_CFG.SMP.
An existing GEF_CFG.INI file may have invalid communications configuration parameters.  These invalid
settings can cause the automatic reconnection feature of Control to fail, or can cause communications
timeouts.  If you choose not to overwrite your existing GEF_CFG.INI file when installing, please make the
following adjustments by selecting Comm -> Communication Setup, going to the Ports tab, and looking at the
advanced parameters:

The "RequestTimeout" must be 16000 or larger

The "SNP_T3" timer must be at least 250 more than the "RequestTimeout"

The "SNP_T3P" timer must be at least 250 more than "SNP_T3"

The "SNP_T3PP" timer must be at least 250 more than "SNP_T3P"

• If Control and CIMPLICITY PC Control are installed on the same machine, un-installing CIMPLICITY PC
Control will cause Control to lose the ability to communicate with PLCs. Do not un-install CIMPLICITY PC
Control unless you plan to remove both packages from the machine.

• When CIMPLICITY HMI is installed onto a machine on which Control is already installed, you may
experience a General Protection Fault or other such error upon opening Control.  If you encounter this
condition, you will need to reinstall Control.  Once the reinstall completes, you will be able to use Control
again and the HMI will still function correctly.

• Folders created using previous versions of Control may need to be moved using Explorer (or by some other
means) if you change the default folder directory and want all folders to be in one directory.  To move the
folder, you must move the entire directory structure of folder as well as the equipment folder file.

The directory structure will be a Windows subdirectory with a name of <folder_name>.dir_<equipment_type>
where <equipment_type> is ef7 for 90-70 folders, f3x for 90-30 folders, and f2k for VersaMax folders.

The equipment folder file has the form of <folder_name>.<target_extension> where <target_extension> will
be .ef7 for 90-70 folders, .f3x for 90-30 folders, and .f2k for VersaMax folders.
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11. Registering Control
 At the end of the installation process, you have the option of registering your copy of Control. To license your copy of
Control, enter the serial number, located on the back of the CD-ROM case, in the User Information dialog box which
displays through Options Setup.  Fax the Serial Number along with the System Key Code to the attention of the
software registration coordinator at 804-978-5099.

Note: Re-installing Control will cause the system key code to change.

12. Trial License Operation
If you do not register your version of Control or do not have a licensed copy of Control, the product will operate under
a trial license for four days. The trial license mode provides access to all product features for four days.  During the
four-day trial license period, you can create product equipment folders. Each time you start Control, a message box
will appear showing the amount of time remaining for the trial license.  When your trial license expires, you will need
to register your system or reinstall Control to continue using the product.

13. Windows 2000 Operation
Control Version 2.30 has been tested with Windows 2000, Microsoft Office 2000, and Corel Office 2000.  There are
no known problems running with either Microsoft Office 2000 or Corel 2000.

In order to successfully run the product with Windows 2000, service pack 1 must be installed.  If the service pack is
not installed, there is one known problem.  Due to an issue with Microsoft’s Jet engine, data returned from database
queries may be randomly lost.  Because of this, folder corruptions can randomly occur during operation.

14. Removing Unused Variables
Control Version 2.30 may crash if you attempt to remove unused variables by opening a block and then selecting Edit-
>Select All followed by Edit->Delete in the Variable Editor.  In order to avoid this problem, use the Purge option
available from the Variables menu in the Variable Editor.
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Product Compatibility
Control Version 2.30 provides programming and hardware configuration support for the Series 90-30 Model 350 and
higher, Series 90-70, and VersaMax Model CPU001.  With restrictions described later in this section, this release
provides the same feature set as Logicmaster 90-70, Version 7.02, and Logicmaster 90-30, Version 9.02, with the
following exceptions: Single word changes on the 90-70, mixed reference tables, and Remote Rack Configuration
(BEM733). Additional features beyond Logicmaster 90 for SFC programs include support for up to eight actions per
step and the ability to program SFC in 90-30 and VersaMax subroutines.

1. Hardware Compatibility

a) This version of Control supports the following 90-30 modules:

90-30 CPUs CPU350, CPU351, CPU352, CPU360, CPU363, CPU364

90-30 Discrete I/O All modules supported

90-30 Analog I/O ALG220, ALG221, ALG222, ALG223, ALG390, ALG391,
ALG392, ALG442

Communications CMM301 GENIUS Communications Module

CMM302 Enhanced GENIUS Communications Module

CMM311 Communication Coprocessor

CMM321 Ethernet Interface (EM3)

PBS105 – Profibus Slave

Motion APU300 High Speed Counter Module

APU301 Motion Mate APM 1-Axis

APU302 Motion Mate APM 2-Axis

APU305 90-30 I/O Processor Module

MCM001 Digital Servo Interface Unit

DSM302 Motion Mate DSM

Bus Controller BEM334 90-30 GENIUS Bus Controller

PBM100 Profibus Master, PBM101 Profibus Master

Intelligent Option Modules PCM300 Programmable Coprocessor 160KB

PCM301 Programmable Coprocessor 192KB

PCM311 Programmable Coprocessor 640KB
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b) This version of Control supports the following 90-70 and GENIUS modules:

90-70 I/O All modules supported

GENIUS devices All  GENIUS I/O blocks are supported

FIELD CONTROL
I/O

 FIELD CONTROL I/O using the GENIUS BIU are configured as generic I/O on
the GENIUS Network

2. Configuring Remote Racks with Control, Version 2.30

a) Control does not support remote rack configuration (IC697BEM733). However, remote racks can be
configured for use over the Genius Bus using the following procedure:

b) Configure the Genius Bus Controller

c) Expand the Genius Bus

d) Add a Generic I/O block at the System Bus Address of the remote 90-70 I/O rack.

e) Configure the remote rack using Logicmaster 90-70.

3.  Communications and Online Monitoring

• Control supports SNP and Ethernet (TCP/IP) communication with the PLC. For SNP connections with 90-70
CPUs earlier than release 6.0, communication must be disconnected in the folder before a connection can be
made to the fault tables

                                                       

* Release 4 or later 90-70 CPU firmware
** Release 3 or later 90-70 GBC firmware required

90-70 CPUs*

CPU731 CPX772

CPU732 CPX782

CPU771 CPX928

CPU772 CPX935

CPU780 CGR772

CPU781 CGR935

CPU782

CPU788

CPU789

CPU790

CPM914

CPM915

CPM924

CPM925

90-70 Intelligent Option Modules

CMM711 Communications Coprocessor
Module

CMM741 Ethernet Controller Type 1

CMM742 Ethernet Controller Type 2

BEM713 Bus Transmitter Module

BEM734** GENIUS Bus Controller Module

PCM711 Peer Communications Module

HSC700 High Speed Counter Module
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• When storing hardware configuration via Ethernet (where the configuration information for the Ethernet
module has changed), PLC communication will disconnect and reconnect. At this time, the privilege level is
always set at the lowest level.

• When storing hardware configuration to a 90-30 351, 352, or 363 CPU using SNP connected to the ECSM
port on the CPU module (not the port on the power supply), an error will be reported at the end of the store
and Control will temporarily lose communications.  This happens because the CPU resets the port at the end
of the store.  To determine if the store was truly successful, you should check the details of the stored items
for failures.

• If you are online and equal with a 90-70 PLC, any changes in logic will cause that block to go to the Not
Saved state. Only the folder copy of the block has been changed and there will not be any prompts before the
change is made. If the change is intended, you can select Store Program Changes from the right mouse button
menu (or press ALT-S) to compile and send the changes to the PLC. If the change is not intended, you must
close the block without saving to abort the changes. If the PLC is a 90-30 and the change is a single word
change, it will go through the Word-for-Word change process, allowing you to abort the change or send it
directly to the PLC.

4. Software Compatibility

a) Control supports the creation of C program blocks and standalone C programs for both the Series 90-70 and
90-30 PLCs. This capability requires use of the C Programmer Toolkit (IC641SWP709 and IC641SWP719).

b) To use C programming on the 90-30 requires CPU Version 8.00 or higher. To use C programming on the
90-70 requires additional files for the toolkit. Call GE Fanuc PLC Technical Support for more information:

USA and Canada……………… 1-800-GEFANUC (1-800-433-2682)
All other Nations……………… 804-978-6036

5. Importing Logicmaster 90-70 Folders into Control

a) Control provides the capability to import Logicmaster 90-30 350 and higher folders, version 4.0 or higher,
into Control.  (Logicmaster 90-30 folders created prior to Version 4.0 must be updated to Version 4.0 before
attempting to import.)

b) Control provides the capability to import Logicmaster 90-70 folders, version 4.0 or higher, into Control.
(Logicmaster 90-70 folders created prior to release 4.0 must be updated before attempting to import.)

c) Control’s rules about variable, block and program names differ from those for Logicmaster 90. To minimize
the time required to prepare the Logicmaster 90 folder and reduce the errors generated during the import
operation, make sure the Logicmaster 90 block names and nicknames conform to the following rules:

• Variable names and block names cannot contain the following characters:

 double underscore  #  +  -  @

 <  >  =  &  %

 A variable name (nickname) that contains any of the characters listed in the above table will be
considered invalid. Application folders should be reviewed for accuracy prior to import. Any invalid
variable names will be discarded, and the reference address will be used instead.

• Variable names may not be used as program or block names. All block names must also be changed to be
compliant with the naming restrictions before being imported.

• The following set of reserved words may not be used as variable, program or block names. In addition to
the reserved words, function block names are also reserved words, and may not be used as variable,
program or block names.
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Reserved Words

ACTN1, ACTN2, ACTN3 ... ACTION AND
ARRAY AT ADD
BODY BY BWAND
ANALOG_STATE BOOL BOOL_STATE
BWOR BWXOR BYTE
CONN1, CONN2, CONN3 ... CASE COMMENT
CONFIGURATION CONSTANT
DATE_AND_TIME DELAY DESCRIPTION
DINT DO DWORD
EDGE ELSE ELSIF
EN END (invalid for 90-30 only) END_ACTION
END_CASE END_CONFIGURATION END_FB_INTERFACE
END_IF END_PROGRAM END_REPEAT
END_RESOURCE END_SEL END_SIM
END_STEP END_STRUCT END_TRANSITION
END_TYPE END_VAR ENO
EXIT
FALSE FB_INTERFACE FOR
FROM FUNCTION FUNCTION_BLOCK
FUNC_INTERFACE IF INITIAL_STEP
INT INTERVAL JUMP
LANGUAGE LREAL MACRO_STEP
MCR MOD NOT
OF ON OR
PRG_INTERFACE PRIORITY PROGRAM
PTR READ_ONLY READ_WRITE
REAL REPEAT RESOURCE
RETAIN RETURN RPTR
SEL_BRANCH SIM_BRANCH SINGLE
SINT STACK_SIZE STATIC_DATA_SIZE
STEP STRING STRUCT
SUMMARY SUB STEP1, STEP2, STEP3, ...
TRANS1, TRANS2, TRANS3,
...

TASK THEN

TIME TO TRANSITION
TRUE TYPE TYPE_EXTERNAL
UDINT UINT USINT
VAR VAR_ACCESS VAR_EXTERNAL
VAR_GLOBAL VAR_INPUT VAR_IN_OUT
VAR_OUTPUT VOID WHILE
WITH WORD

Note: The Logicmaster Import function has been extensively tested. However,
there may be cases where the logic in very complex rungs does not import
correctly. Error messages in the output log stating “Dangling Horizontal”,
“Illegal Rung Topology”, “Dangling Vertical”, or “Internal Error -
Unable to Draw Rung Properly” should normally appear upon a compile
of the folder if any problems were encountered. However, it is
recommended that you print and review the logic after importing the
folder.

Check the GE Fanuc Web site or BBS Control area for more detailed
information on importing Logicmaster folders.
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6. Temp Folder Differences from Logicmaster 90

 Temp folders in Control behave differently than in Logicmaster 90 when doing a load to Temp.  Logicmaster 90
clears everything in the Temp folder before doing the load.  Control clears only the items that are selected to be
loaded.  It is recommended that the Temp folder be cleared or deleted before a load to Temp is done.

7. LD Compatibility with Logicmaster 90

a)  Control has an option setting that facilitates sharing Ladder Logic PLC programs between Logicmaster 90-
70 and Control. This option is not necessary for the 90-30 since programs created are compatible unless you
create rungs that extend beyond ten columns. When you use Control in LM90 Compatibility mode for a 90-70
folder, you can store a folder to the PLC and load it into either Logicmaster 90 or Control.

b) Using Logicmaster 90-70 Version 6 or later or Logicmaster 90-30 Version 4 or later, you can upload a
Control-created RLD program from the PLC into the TEMP folder (or an equipment folder with a name that
matches the program name in the PLC).  Logicmaster will indicate an EQUAL status and be able to monitor
activity in the PLC.

c) Control is able to upload a Logicmaster 90 created RLD program from the PLC and go ONLINE and
EQUAL.  You can make changes to the program and update the program without having to STOP the PLC.

d) The Compatibility mode can be activated from the Workbench. With the Browser window selected, go to the
Tools menu, select Options, then select Equipment Folder.  The Equipment Folder Options dialog box allows
you to enable or disable LM90 Compatibility.  The default is Disabled.  (The setting will automatically default
to Enabled during folder import conversion of an LM90 folder to Control).

e) The following notes also apply to Logicmaster 90 compatibility:

• Blocks must be less than 16K bytes.  A compile error will be issued when in LM90 Compatibility mode if
the block exceeds the limit.

• Warnings will be generated when double-wide precision instructions or Calls do not have adequate
spacing for the Control display format.

• When loading a program from the PLC that was created with Logicmaster 90, you do not have to compile
the program loaded into Control unless changes are made after the load into Control.

8. SFC Compatibility with Logicmaster 90

a) Folders that contain SFC blocks created with Control are not compatible with Logicmaster 90. You should not
attempt to use Logicmaster 90 with a PLC that contains SFC blocks created with Control. For 90-70 folders,
SFC blocks will not compile (an error will be placed in the log) if LM90 Compatibility mode is enabled.

b) Some simultaneous and selective constructs that were allowed in Logicmaster 90 are restricted in Control in
order to maintain IEC Compliance. You will need to edit the Logicmaster 90 folder before importing it into
Control.

c) Logicmaster 90 connectors will be changed into directed links during import into Control.

9. Control Compatibility with VersaPro Software

a) Control Series 90-30 folders can be imported into VersaPro.

b) Control will not prevent a user from attempting to upload folders stored to a PLC using the VersaPro
programmer; however, attempting to do so is not recommended and will not be supported by GE Fanuc
Automation.

c) Control supports SFC for VersaMax.  VersaPro does not support SFC, and Control programs which have SFC
must not be imported into VersaPro.  Testing of this has not been done and the results are not guaranteed.
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New Features Introduced in Control Release 2.30
1. Referential Integrity Relaxation.  This feature allows two variables of the same scope to be defined at the same

address independent of their other attributes (type, length, stored value, etc).  Previously, two variables could share
the same address only if they had different types or were at different scopes.  It is the user’s responsibility to
ensure that different stored values are not used for the two variables (a warning appears in the log window during
compilation if this occurs).

2. FIP Transfer Variable (TVA) Phase 2.  In previous versions of Control, a TVA could only be associated with a
variable to represent the data packet as a whole.  Such an assignment masked or ignored the fact that many times
a TVA is a collection of many I/O points or channels from a module.  To properly reflect this collective nature of
a TVA, a mechanism was devised where a TVA can be “expanded” to allow assignment of a variable to each of
its parts.  This mechanism is embodied in the FIP TVA Phase 2 feature added to Control 2.3.

3. Import/Export of Hardware Configuration.  In previous versions of Control, the only way to reuse existing
Hardware Configurations was to copy and paste modules from one folder to another folder.  Control 2.3 supports
exporting the Hardware Configuration (with the exception of Ethernet Global Data and Name Resolution) to a
comma-separated text file which can then be imported into other Control folders.

4. Association of a Device with a Main Device.  Since Control 2.3 does not support configuration of redundant
devices, this feature was introduced to provide pseudo-redundancy.  When a main device is created with the
Communications Configuration Utility (CCU), another device may be associated with it.  Once this is done, the
two devices can act as a pair of devices.  For example, when connecting to the main device, the second device may
be automatically connected.  In addition, when logic is stored to the first device, the second device may have the
same logic stored to it when the store completes on the first device.  Similarly, Run/Stop transitions may also be
done in this manner.  If selected, once the transition is done on the main device, it is automatically done to the
second device.

5. Event Component.  Control 2.3 provides the ability to execute external actions on the occurrence of specific
events within Control.   A broad category of events in Control may be used to trigger actions.  These include the
Open, Close, or Save of Folders, POUs, Rack Systems, Buses, and Libraries as well as the Open or Close of the
Configuration Variable editor.   The user sets up (“configures”) what actions (if any) should occur for any of these
events by using the Event Configuration Manager  under the Tools menu.   An action consists of a name and a
command, which specifies a path to an executable file.  When the Event Manager Client is started (also from the
Tools menu), the monitoring of Control events starts and configured actions will be executed when their trigger
events occur.

6. Allowance of EX7 to be a Clock Provider.  This version of Control allows the EX7 to receive the network clock
synchronization signal which allows the CPU to synchronize its clock with the system clock.

7. Printout Changes for Long Variable Names.  In logic and variable printouts, this feature allows the user to
distinguish long variables that have the same leading characters.  Only 20 characters are available for variables in
the logic printouts.  Without this feature, if multiple variables were used that had the same first 20 characters, they
would be indistinguishable in the printouts.   This feature makes each variable unique in the logic printout by
shortening each and appending ~1, ~2, etc.  In the Variable printout, both the full name and unique name are
printed allowing the user to identify which variable is being used in the logic.

8. New 90-30 Power Supplies.   Control 2.3 supports two new 90-30 power supplies.

Cat No. Description
IC693PWR331 Power Supply 24 VDC 30W

IC693PWR332 Power Supply 12 VDC 30W
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9. New VersaMax Power Supplies.   Control 2.3 supports two new VersaMax power supplies.

Cat No. Description
IC200PWR201 Power Supply 12VDC Input

IC200PWR202 Power Supply W/Expanded 3.3 VDC 12VDC Input

10. Generic Configuration of VersaMax Modules.  The list below shows the known list of new VersaMax I/O
modules and their associated module IDs which use Generic I/O configuration.  It is anticipated that additional
modules will be introduced and will require Generic I/O configuration using this version of the programmer.

Cat No. Description Generic Config
Type

IC200ALG260 12 Bit Analog Input, Volt/Curr, 8 Channel Analog input

IC200BEM103 DeviceNet Network Master/Slave Communications

IC200MDD845 Mixed 24VC In/ Relay Out 16/8 Discrete Mixed

IC200MDD846 Mixed 120VAC In/ Relay Out 8/8 Discrete Mixed

IC200MDD847 Mixed 240VAC in / Relay Out 8/8 Discrete Mixed

IC200MDD848 Mixed 120VAC In/ 120VAC 0.5A Out 8/8 Discrete Mixed

IC200MDL140 120VAC 8 Pt input Discrete input

IC200MDL141 240VAC 8 pt input Discrete input

IC200MDL329 120VAC 8 Pt 0.5A output Discrete output

IC200MDL742 0.5A 24VDC Out ESCP 32 point Discrete output
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Problems Resolved in Version 2.30

Note: Problems fixed in Version 2.30 Service Pack 1 are marked with a “*”.

Communications

1. Variable Declaration Table does not display Equality/RTU after Offline/Online transition.

Set focus on the Variable Declaration Table (bottom splitter of LDedit), go Offline or Disconnect then go Online or Connect. Real Time

Updates and status do not update. Click in LD Edit and the click back in Variable Declaration Table to restore Real Time Update in Variable

Declaration Table.

2. Store to PLC successful when the Compilation reports “Conflicting Retentive Attribute” errors for
VersaMax folder.

Program will work correctly. Retentive Attribute errors should be corrected..

3. Error handling is not proper when changing privilege level with wrong password.

There are some issues with changing privilege level in the fault table application.  If the user gives an incorrect
password, the privilege level does not change as expected but the dialog closes and the user is not given feedback that
the password was incorrect.  If the password is correct, the privilege level does change, but when the dialog is brought
back up, the incorrect privilege level is displayed.

4. Real Time Update STOPS in Reference tables.

Serial Communication only – Intermittently, if you disconnect and reconnect communication in the fault table, without
closing the fault table, the Real Time update in the Reference tables, Watch Windows, and LD Edit can stop updating
with no indication of a problem. You can change values and still not realize that Real Time Updates are stopped.
Resizing the Window will cause Real Time Update to resume.

5. Comm error: Fault table - Does not connect when folder and Watch Window are connected.

Occasionally, there are problems connecting from the fault tables when the watch window is active.  This occurs only
after multiple connects and disconnects are done with a serial connection.  When this occurs the data in the watch
window will not display (i.e. the values will appear as ?????).  The workaround is to close and reopen the folder.

6. Crash during connect/disconnect operation.*

When multiple reference tables are opened and being updated very quickly, Control would occasionally crash after two
or more connect/disconnect pairs.

Hardware

1. Control generates illegal OFF/ON PRESETS for the type A counters on the HSC.

Changing High and Low Limits can cause the Presets to change to incorrect values. Workaround is to check the
Presets and Preload value and enter correct values.

2. Cannot type in path for  Profibus *.GSD file.

Problem on NT only.

The extension comes up as .gs?  Workaround is to browse to the file, you will need to Map the drive if it is a network
drive

3. CONFIG_VERSION miscompares on Verify.

If your Hardware Configuration contains scan sets, you will notice that verifying your Hardware Configuration will
cause miscompares in the CONTROL_VERSION.  The data in the PLC is correct and there is no effect on the
operation of the folder.
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Workbench

1. Wrong floppy count when restoring a folder from multiple floppies.

When a folder is backed up to two floppies because the size of the folder is larger than the standard 1.44MB floppies
and the user restores the folder from the floppies, the user gets the following incorrect message when the first floppy is
requested: "Please, Insert disk number 1 of 1”  appears for inserting the first  floppy instead of “1of 2”.   Next a
message "Please, Insert disk number 2" appears for inserting the second floppy instead “2of 2”.

2. Save As loses EGD variable definitions when connected to PLC.

Store a folder to a PLC that supports Ethernet Global Data and the status will show the PLC is equal.  Remain
connected to the PLC, perform a Save as operation to  change the folder name. The folder and folders program names
will change to the new name and the folder will show Not Equal (continue to stay connected to the PLC).   Store all
components to the PLC which will cause  a Build operation.  Upon completion of this operation, the user will get an
error messages, "Ethernet Global Data binary is invalid” followed by Store to PLC - Results: “Error was detected
(7116) Hardware Component Failure”.  No PLC faults will be reported and the folder (now with a new name) will
remain Not Equal.  When opening  Hardware Config/EGD, the user will get the message "One or more of the
variables in EGD have been deleted."  The user will find that exchange Status Word variables are blank and some
variables although not blank have no definition.  The Adapter Name and the Name Resolution components will be
unaffected.  To avoid this problem,  disconnect from the PLC before doing a Save As.

3. Side effects from renaming Active X controls.

Active X Controls that used to work, now appear with bad icons and cannot be activated or removed from the folder.

Workaround: For release 2.20, the rename function for active x controls is disabled.  This will prevent this problem
from occurring.

Software Resource and Programming

1. External EXM “C “ program creation is sequence dependent.

EXM programs should have a LD block with the same name as the program.

When the block is created before the EXM program, the program creation fails giving a cryptic message

     'Unable to Create program'

Workaround is to create EXM program first.

2. Program Store not triggered when Copying and Pasting Operands in the Ladder Logic Editor.

See Operational Note #1.

3. The addresses of indexed, named alias variables is different in the Ladder Logic Editor and the Variable
Declaration Editor.

See Operational Note #2.

4. 90-30 Code generation stack limit check is incorrect.*

The 90-30 only supports a stack limit of 8 for boolean opcodes.  This limit was not being checked by Control.

5. Address of array element is wrong.*

Array elements accessed on contacts were being assigned the wrong address if such the access was made in an AND
expression and it was followed by an AND expression.
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Variables

1. Logic paste causes variable scope to change from Program to Config if duplicate variable names with
different addresses are involved in the paste.

Any program scope variables which are being pasted and have the same name as variables in the target folder and
have different addresses will have their scope changed to config. Inspect variables involved in paste to insure they have
the correct scope.

2. Watch Window display problems for BYTE type variables.

a. Changing a display mode to binary in Watch Window for a BYTE typed variable can corrupt the display of
other vars.  This can occur if a byte variable is in the Watch Window and other variables from the same
reference table as the byte variable  are also in the Watch Window .  The problem occurs if the byte variable
or any variable earlier in the reference table is displayed as binary.  Variables after the byte variable can be
changed to binary display mode with no problem.  The byte variable must be dropped into the Watch Window
before other variables to see the problem.  In order to avoid this problem, do not display BYTE variables in
BINARY mode.

b. When Byte variable types are displayed in Hex mode, no updates occur to any variable in the Watch Window.

3. Watch Window data entry problem for Double Word type variables.

When a DINT, DWORD, or REAL variable is being display in binary format in the Watch Window, there is no update
of the upper word in PLC memory when the binary data is entered.  Only the last 16 bits of data entered in Watch
Window are accepted.  All other data is ignored.

4. Find in Vardec does not work under Windows 2000.*

When using the Vardec’s Find operation under Windows 2000, the Find operation will locate no variables.

5. Printing typecast variables causes a crash.*

Printing variables that are typecast to arrays would cause Control to crash.

Help

The "How to use Help" fails and reports a missing wb.hlp file.

The customer brings up the Help menu, selects “How to use Help,” and the error message “Cannot find the
c:\cimplicity\control\wb.hlp file” appears.  First select the “Contents,” then “How to use Help” will work once.



16 Important Product Information

GFK-1882

Restrictions and Open Problems

Communications

1. Time-outs may occur during a store using SNP.

It is possible to lose communications intermittently during a store operation over SNP. The problem may be
experienced with very large programs, or if running  Control on a PC with little available RAM. To reduce the
likelihood of this problem occurring, limit active applications during the store, or add additional RAM. If you
experience this problem, repeat the store operation.

2. Saving folders to Novell drive.

Saving folders to Novell drives that require an 8.3 format is not supported. You must use the newer version of Novell
which supports longer filename suffixes.

3. Performance tip.

For best performance when using the "Store Program Changes" (ALT-S) or Word-for-Word changes feature, you
should, upon opening a folder, perform a build using the Rebuild All command. This will allow subsequent Store
Program Changes or Word-for-Word changes to occur faster.

4. Method to expand Target Communications Window (right click on title bar) is not obvious.

To expand this window so that you can view detailed information, click the right mouse button in the title bar of the
Target Communications window.

5. Synchronizing CPU time to Host may cause Run and Stop buttons to display incorrectly for a few seconds.

To correct this problem, disconnect from the PLC and then reconnect.

6. Fault table continues to show faults after connection with PLC is terminated.

It is not possible to clear the fault table screen when disconnected. To clear any messages logged in the fault table, you
will have to reconnect to the PLC.

7. Incorrect error message.

Disconnecting the communications cable from the PLC for an extended period of time can randomly make the
message “Maximum number of users for requested port has been reached” appear.  Exiting Control and re-entering
may be required to reconnect to the PLC.

8. Cannot connect to PLC if both Genius buses in a Dual Bus/Internal Configuration are open.

Close one of the busses to perform the connect.

9. Passwords changed in Control will not be reflected in the Fault Tables.

10. Communication errors to Genius Field Control BIU after initial store if BSMPresent  is enabled.

With either of the Genius Field Control BIUs, There are communication problems with any attempts to store to the
BIU after a store with BSMPresent enabled.  One of the following two error messages is displayed:

[1] Error is storing (downloading) configuration to device 1 - (7a70)Device did not accept the message or timed out.

[2] Error in comparing configuration data; comparison terminated.

11. Wrong Error message on trying to Store Bulk Memory.

If a folder has BMA configured  and you attempt to store the folder BEFORE connecting to the PLC, Control displays
an error message that the CPU does not support BMA when the error message SHOULD inform the user the
programmer is NOT connected to the PL.
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12. Incorrectly reporting “Not Connected to 90-30 PLC Error 82” message after a store to the via Ethernet PLC
when Ethernet board is not configured.

If the 90-30 hardware configuration has missing Ethernet module or is configured with an Ethernet module with
inappropriate IP address in its parameters,  the user will get the (82) Not Connected to PLC error after storing logic to
the PLC via Ethernet.  However, the logic is stored, and Com Status shows connected.  If the user adds an Ethernet
module with IP address, the store will be completed successfully without the error message.

13. Word For Word problem: Replacing a non-retentive coil with a retentive coil causes 90-30 PLC folder to be
not equal.

A message saying Retentiveness of variable will change, then the Word for Word dialog will appear. Both LDEdit and
Hardware Config stay EQUAL. Workaround to get the folder equal is to do a store and select ONLY Global Vars (Ref
Table). An message will appear saying PLC must be stopped and the Store will not occur, but the folder will go
EQUAL.

14. Resource Name mismatch Error while store to 90-70 PLC when using folder names longer than 7 characters.

Create a folder (for example 'mtldtest2.ef7' ) which is more than 7 characters long.  Connected to a 90-70 PLC  and
clear the PLC.  Stored Hardware config alone in STOP mode. The name of the PLC Program is shown in the 'Store to
PLC - Results' dialog box is 'MTLDTES' (truncated to 7 characters due to PLC limitation).  Place the PLC in Run
mode and do a Run-Mode store of SW Config alone.  The Store is not successful and the error message says “Resource
Name mismatch”.  The PLC Program name shown in 'Store to PLC Results' dialog box is 'LDTEST2' (truncated from
the other direction).  The work around is to use folder names with 7 characters or less.

15. Control sometimes displays not equal, when it is equal to the PLC.

After store completes, verify the PLC with the logic in the folder.  The verify operation produces "All Items Equal to
PLC", but displays "not equal" on the folder's browser window.

16. Special sequence to connect Associated device in the Fault Tables.

When using Association of a Device feature in the Fault Tables, it is important to ensure that all fault windows are
closed before bringing up the main connection.  If this is not done, it may appear that no connection is made to the
associated device.

17. Multiple instances of HDRVSNP.EXE causes communication problems.

When running Control, serially connecting and disconnecting target comm, Fault tables, and/or switching between 90-
70 and 90-30 folders causes multiple instances of HDRVSNP.exe to be running.  The number of times you have to
connect/disconnect and in what order (Fault tables first or 90-70 target comm or 90-30 target comm first) is unknown
and seems very random.

When this condition occurs, you will see strange communication errors.  Such errors include a fault table
disconnection that seems to coincide with the opening and closing of unrelated windows, disconnecting Fault table
also causes target comm to disconnect, etc.

18. When Serial connection is selected, Ethernet connection is also made.

If the Association of a Device with the Main Device feature is used, when a serial connection is made to a device it
may also connect to the device’s associated device.  In order to avoid this behavior, select an Ethernet type port and
ensure the “Also Connect Associated Device” is unchecked below selecting the serial connection.

19. Stored Values for some 90-30 variables are not created correctly during a Load to TEMP.

When loading a 90-30 program from the PLC to an empty TEMP folder, the stored values for bit variables with
memory types of %I, %Q, and %M are not created correctly.  The stored values created for these types of variables will
depend on the value in the override table in the PLC for the given address.  If the override is not set, no stored value
will be created.  If the override is set, a stored value of 1 will be created.
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Hardware

1. Copying and pasting a Type 2 Ethernet module from one folder to another does not copy and paste EGD and
Name Resolution entries.

After performing a paste, you will need to go to the Ethernet Global Data and Name Resolution menu items and enter
the values manually.

2. Storing HWCFG does not store Genius configuration to blocks and there is no message telling you block
configurations are not being stored.

You should store the configuration from the Genius Configuration tool (accessed by choosing Expand Bus from the
right mouse button popup menu). You will need to open the Genius Bus objects one at a time and store them.

3. Reference Addresses on Hardware Modules - drag and drop changes them.

 If you manually change the reference addresses of modules to overlap, and then dragged one of the overlapping
modules, the module (on insert or drag) re-evaluates the reference address to make sure it is not conflicting. Since the
module is overlapping, it resets the address to the next available location to remove the conflicting range.

4. Can’t set Constant Sweep higher than 2550 milliseconds.

The constant sweep time cannot be set higher than the Watchdog Timer, which has a limit of 2550 milliseconds.

5. Pasting a Genius bus to the browser then double clicking on it causes Fatal System Error.

6. Configuration does not verify equal after storing a 350 or 360 configuration to a 351 / 352 CPU.

Storing a 350 or 360 configuration to a 351 CPU results in configuration not equal. Change HWCFG to 351 to fix.

7. Browser focus can get confused on Genius Dual Bus.

Browser can get confused as to which bus the primary or the starred should have focus. Leave the browser and return
to fix the focus

8. Name Resolution and EGD files missing Type 2 Ethernet adapter name in redundancy mode.

The Type 2 Ethernet adapter should have separate names in the primary and backup. Only the last name entered
appears. This does not cause operational problems.

9. Aborting Clear of a large folder in 90-70 PLC may cause Fatal System Error on Windows 95.

After Storing to a 90-70 PLC a program of substantial size, containing name resolution and EGD, if the PLC is
cleared using the Utilities Clear Dialog, a Fatal System Error may occur when running on Windows 95, if the clear
operation is aborted prior to completion.

10. After a Load of Hardware Configuration, if the Network Address Name field is edited before the Adapter
Name has been redefined on the Ethernet Global Data dialog, it will be impossible to exit from the dialog.

This problem can be avoided by re-entering the Adapter Name after the load before editing any other fields in the
EGD dialog.  If the Network Address Name field is accidentally edited first then Control must be killed through the
task manager.

11. When configuring the HE693PBM101, the configuration of Manufacturing Specific Data in the fields Mfg 1,
2...15 is not taken into account.

Thus, communication to Profibus slave devices that require Manufacturing Specific Data is not supported in this
release.

12. Genius Field Control BIU configuration does not recalculate the starting address when the length is changed.

When Genius Field Control BIU configurations are changed, the length and starting address need to be verified and
corrected if necessary.

13. Cannot store config of MFP in Genius Field Control.
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In Genius Field Control, attempts to store a config that is not identical to the current config of the MFP fail and list all
parameters that are different.

14. Compatibility Issue in storing HW Config from earlier Control Folders.

The error message displayed states that the there is a CPU model mismatch, even though the CPU in the folder and the
rack are exactly the same. Workaround – delete the module and re-enter, internally the representation has been
enhanced for new features.

15. Not all parameters for the VersaMax ALG630 module are checked completely.

Incorrect combinations of parameters choices are allowed. Upon download to the PLC, a fault table entry of “System
config mismatch will occur”. Parameters will need to be corrected using VersaMax documentation, and the HWCFG
will need to be Stored again.

16. Help button does not work on Genius Bus Device Catalog.

Win98 and WinNT.

Open a Genius Bus to get the picture of 32 nodes.

Double click on any empty node to get a "Device catalog" dialog box.

The help button does not work on this dialog.

17. CGR772 and CGR935 CPUs do not support RTU protocol.

The Series 90-70 CPUs do not support the RTU protocol for CPU ports.  Control incorrectly has configuration choices
of this protocol for the CPU ports.

18. Hardware Config allows you to use an auto-located, named alias variable as an EGD exchange variable.

If you create an auto-located, named alias variable and then build the folder so the variable is given an address, you
will be able to use this variable in an EGD exchange.  If you do this and then change the auto-variable locate ranges or
add new variables and then rebuild the folder, your EGD may stop working since the variables have been relocated.

Workbench

1. Default Drive may be blank if previous work in Control referenced a network drive.

Dialog boxes which reference the default drive may contain blank fields if previous functions performed in Control
(like OLE Containment) set the directory to a network drive which was not mapped.  To correct, simply reselect the
default drive and folder location in the dialog box.

2. Losing track of active windows from menu.

You may not be able to see all the active windows in the list displayed from the Window menu. Active windows can
still be found on the screen.

3. The Save Changes dialog only appears in the Equipment Folder when the folder is first created.

The Save Changes dialog box appears the first time you close an equipment folder after it has been created. Operations
such as Delete and Cut will not cause the Save Changes dialog to be displayed. If you create a new folder and exit, you
will be prompted to save the equipment folder. However, if you create a new folder, insert some blocks, and then delete
a block, you will not be prompted to save, because the deletion saves the folder automatically.

4. Save As does not work to server name for networked drives.

You should map the drive to a letter.

5. Importing a block from the Librarian does not include the blocks that the imported block calls.

You will need to manually import blocks that are called, or create temporary blocks with the same names as those
being called.
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6. Pasting a special object (*.csv) into the browser with same name as the program  causes crash.

Use the Edit->InsertObject->CreateFromFile command to attach a csv file to the equipment folder.  If the name of the
pasted csv file matches that of the underlying node, the node is replaced.   This seems to work fine if the inserted
object has a different name.

For example:

a) Create a new folder named "Test".

b) Create a test.csv file.

c) From the Test SWConfig node, use the Insert Object->CreateFromFile to attach the test.csv file.  Notice that
after the insert, the Test Resource node has been replaced with an Excel icon.

d) Do a rebuild all to create the Fatal System Error.

7. %L variable cause Online updates to blank out in PSB and SUBR.

(90-70 only) If a %L reference address variable is on the screen in a PSB or SUBR all Real Time Update values are
blanked out. This occurs in both LD Edit and the Variable Declaration Table. Workaround is to not use %L addresses
or to scroll the %L off the screen.

8. Cannot Insert Object by 'Create From File' in Browser. Causes premature termination.

Microsoft documents saved in Office 95 or Office97/Office95 format have this problem. Resave documents in Office
97 format.

9. SFC program goes Not Saved after import and a rebuild all.

Workaround is to Rebuild All a second time.

10. Selecting Network button on Import Equipment Folder dialog causes crash.

The programmer can sometimes crashes if the user selects the "Network" button on the "Import Equipment Folder"
dialog and the user has networked drives connected to their PC.  If the programmer crashes once under these
conditions, it will consistently crash several times when performing this operation.  This tends to occur only if the
local drives are displayed in the drives pull-down even though the PC has some drives mapped to a network (which is
why the user selects the Network button).  If the network mapped drives are displayed in the drives pull-down,
pressing the "Network" button does not cause a crash.  The work-around is to copy folders on network drives to a local
drive.

11. Save As does not function reliably after “LOAD” to "temp" folder.

Workaround - Save the temp folder first, then do a Save As.

12. WB - Status Toolbar hangs after clicking "OK" to daylight savings window.

Windows 95, Windows 98 and Windows-NT:

If the beginning or the end of daylight savings time occurs while Control is running, and the user selects “Yes” from
the Windows’ message box that adjusts the PC’s clock, then the status bar in Control will “freeze” (i.e. the time will
stop, and the INS/OVR, CAPS lock, and NUM lock display will not work).

The Status bar behavior returns to normal after closing and reopening the folder.

13. Unexpected error when attempting to perform Save As using a pre-existing Library name.

If you try to “Save As” for a library to a file name that already exists or is a reserved word you get an error “This file
already exists, or is a reserved device name.  Press cancel to choose another file name or OK to continue.”  If you press
OK, you will get an additional error message indicating “An unexpected error occurred while writing
<library_name>.lbr.”
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Logicmaster Compatibility

1. If a Control folder is stored to a Series 90-70 PLC with LM90 Compatibility mode set, and then uploaded
into a new folder (including "temp"), LM90 Compatibility mode is not set in the new folder.

This can cause Control to lose equality with the PLC. To maintain LM90 Compatibility mode in the new folder, select
Tools menu, Options, Equipment Folder. Check the LM90-70 Compatibility box.

2. Folder conversion of HEX constants.

Constants programmed as HEX and displayed as HEX in Logicmaster 90 will display in decimal format after
importing or loading the folder into Control.

3. Logicmaster 90 and Control with the same COM port.

When using Logicmaster 90, you must exit Logicmaster before attempting to use Control with a serial connection to
the same port that Logicmaster 90 used. If you do not exit Logicmaster, you will receive an error message stating that
the requested COM port could not be opened.

4. A type cast of a variable located in %P memory that specifies a length that extends beyond the last variable
located in %P will cause the size of the %P table to be incorrect.

Execution of a folder that has this problem will cause the CPU to Stop/Fault with Error message of Program
References exceed those configured in PLC.   To correct this, a variable should be declared that is located at the end of
the typecast array variable.

5. Hardware Configuration for 90-70 that contains Genius Global Data will not be able to be loaded by LM90.

The Hardware Configuration data downloaded to the PLC when Genius Global Data is configured is not compatible
with Logicmaster 90-70 and therefore cannot be uploaded into a Logicmaster folder.

6. LM90 program and block descriptions are not imported.

Descriptions need to be reentered after import from LM.

7. OEM Protection in LM90 causes Control to be unable to perform certain operations.

If OEM protection is enabled through Logicmaster, Control will be unable to Load from the PLC or Verify with the
PLC.

Software Resource and Programming

1. The length for Data Init Comm instruction is incorrectly set if the user does not bring up the Data Init
Comm dialog box.

If the information for the Data Init Comm instruction is set through the Insert Variable dialog box (instead of the Data
Init Comm dialog box), the length is not correctly set.  The incorrect length can then be stored to the PLC.  To ensure
that the length is correctly set, double-click the function block, enter data in the Data Init Comm dialog box and click
OK.

2. Control can lock up if an invalid data file (.DI file) is imported into a Data Init instruction.

If a data file is imported into a Data Init instruction, which is not appropriate for the function block type (for example:
importing an ASCII file for the Data Init Comm function), Control can lock up.  To reduce the likelihood of this
problem occurring, verify the .DI file before doing the import.

3. A Fatal System Error may occur if a contact is inserted in front of a series of three or more subroutine calls.

If LD Editor is in insert mode and a contact is placed into column one after having placed a Subroutine call in column
one with additional subroutine calls in columns 2 and 3, a fatal system error will occur.  If this error occurs, any
changes in the active edit session (which have not been explicitly saved) will be lost.

4. Floating-point instructions.

If the CPU is changed from a non-floating point to a floating point CPU while the LD Editor is open, instructions
requiring a floating-point CPU will not display. To view these instructions, close and re-open the LD Editor.
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5. Parameter Edit dialog box.

The Parameter Edit dialog box allows 64 characters for the description field, but will display only 57 characters from
the Header dialog box.

6. Deleting all instructions in a rung does not delete the rung.

To delete a rung, you must select the rung by clicking to the left of the power rail and then delete the rung.

7. Complex 90-30 Boolean rungs failing on compile.

Some 90-30 complex boolean rungs, such as the one in the following example, fail on compile. The error message
“Logic sub-path cannot enter in the middle of another sub-path” is generated.

To work around this problem, insert an ALW_ON contact as a placeholder in the logic, as shown in the following
example

8. Copying and pasting rungs from SFC to LD.

You cannot copy and paste rungs from an SFC block to an LD block or from the terminal LD editor in SFC to an LD
block. However, you can copy from an LD block and paste into the terminal LD editor within an SFC block.

9. Move instructions in 90-30 Equipment Folders. on the Move instruction, cut the instruction, and paste it
farther away from the preceding Move instruction.

In a 90-30 folder, inserting a Move instruction without enough space between it and the next Move results in data flow
from output of first move to input of second move which is not allowed in a 90-30. To avoid this, add sufficient space
between Move instructions to allow the operands to appear. To adjust the placement of the Move instruction, click
once

10. Footer problem when printing Use Table from a block.

Printing Use Table from a block results in the footer displaying a block name when it should not.

11. Variables that are type cast to a larger data type are not found as implicit use in Search.

You must search directly for the reference address if it is type cast in an editor.
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12. Zoom size change does not work if Zoom is typed into LD Edit control.

Click the pull-down control for the combo box so that all the entries are displayed (75%, 100%, 150%, etc.). Now type
the desired Zoom size into the box and press ENTER with the pull down list still open.  The Zoom size should now be
properly reset.  An alternate way of setting the Zoom size is to choose Zoom from the View menu.

13. In LD Editor, data entries which are not completed are lost if you click outside the LD Edit window.

Be sure to complete a data entry before clicking outside the LD Editor.

14. The LD Editor gives an incorrect output messages.

If you insert a named variable of local scope with an address and then use the same name in LD logic, but you give it
Configuration scope and no address, you will receive an incorrect error message, “Variable and called block have the
same name”.  If you give a Data Init instruction a length that is too large, the error message given is “Invalid Array
Operation”.

15. PSB Bool Parameters are allowed as actual parameters.

PSB parameters of type BOOL are incorrectly allowed to be passed as actual parameters to other PSB or External
Blocks.  This should not be allowed since the PLC does not support this.

16. Pasting a rung with a call to a “C” block into a folder where the type of the block is a PSB, does not correct
the call instruction.

If a rung with a call to “C” block from one folder is pasted into a second folder where there is a PSB with the same
name and same parameters, the rung will incorrectly continue to show the call as CALL EXT.  To correct, delete and
replace the call in the rung.

17. Use of %S32 (continuation) directly as an operand may cause programs that compile correctly to not be able
to be uploaded in the 90-30.

If the %S32 reference address is programmed on contacts directly, a program that has been compiled and downloaded
to the PLC, will fail on the decompile after a load (fatal system error).  Use of %S32 directly should be avoided.  The
continuation coil and continuation contacts should be used instead.

18. Instructions with variables that are two words in length can cause “Connect 15” error message.

90-70 folders in LM90 compatibility mode require two columns for variables that are two words in length
(DINT,DWORD,REAL). If the column space is not available, the message “Cannot draw rung – connect 15 error”
will occur. Either move the instructions further apart or move vertical shunts over further to create another column of
space next to the instruction for the two-column variable(s).

19. OR instruction gets wrong length using arrays (90-70).

Placing an Array on IN1 and the same Array on Q with a Constant or Variable of length 1 on IN2, the instruction
picks up the length of the array and treats the variable of length 1 as if it  were the same length as the array.

20. Bit Sequencer length cannot be set without a variable on the ST input.

ST input should be optional. Workaround is to place a variable on the ST input.

21. Vertical Shunts between MAN,UP, and DOWN input on PID_IND instruction cause Recoverable System
Error on compile.

Workaround is to connect the three inputs to the power rail rather than shunting them together.

22. Deleting a comment in SFC then doing an Undo causes text from another comment to replace original text.

If this occurs the text will need to be reentered.

23. 90-30 SFC Run Mode Store resets the SFC network back to initial step.

Run mode stop should not reset an SFC network back to the initial step. Workaround – do not use Run Mode Store
with 90-30 SFC programs use Word for Word change or Stop Mode Store.
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24. Compile of 90-70 PID_IND instruction gives recoverable system errors.

Create a 90-70 folder, Goto Main block, insert PID_IND instruction and  use for example %R200 for the instance
name.  Set SP,PV and CV to %R00001,%R00002,%R00003.  Control the EN of PID by an ALW_OFF contact.
Connect a shunt from the power rail to UP, then connect MAN, UP, and DN together with shunts up against the body
of the PID (forms a sideways "T"). (It is this type of connection that causes the problem.)  Connect the output of
instruction to a coil.  A program compile results in Recoverable system error.  To avoid the recoverable system error,
connect the MAN, UP and DN inputs directly to the rail.

25. 90-30 SFC editor-"OVR" mode switches back to "INS" mode after overwriting one transition.

In the 90-30 SFC editor, "OVR" mode switches back to "INS" mode after overwriting one transition even though the
"Insert" key is not pressed.

26. Compile of 90-30 PID_IND instruction gives fatal system errors.

Create a 90-30 folder, Goto Main block, and create a variable at reference %R500, length 5, Type INT, default scope.
Insert a PID_IND instruction and use variable[2] as instance name (cast to PID_INT will be added).  Set SP, PV, and
CV to %R00001, %R00002, and %R00003.  Control the EN of PID with an ALW_OFF contact, and connect one
contact each to MAN, UP and DN switches.  Connect output of instruction to a coil.  Program compile gives Fatal
system error and crashes.  To avoid the crash, do not use an array element cast as PID_INT and an output coil
connected to the output of the PID instructions.

27. Inconsistent warnings concerning ALW_ON contacts in 90-30 compile with un-normalized logic.

When the user has a rung with a vertical shunt before the first contact, a warning is issued during a compile stating
“Short circuits will be replaced by ALW_ON contacts,” which is expected.  However in some cases, particularly rung
#1, ALW_ON contacts may be added for this same case without warning the user.

28. Accept rungs LD Editor option is set after creation of every new block or load.

Whenever a new block is created (either in the Editor or by a load), the LD Editor "Accept" option is turned on (even
if it had been explicitly turned off).

29. Error pasting blocks that contain the SER instruction from 90-30 folders to VersaMax folders.

Create a 90-30 block with only an SER instruction in it, then copy the block. Open a VersaMax folder and paste the
block.  You will see an error message stating that SER is not supported.  The block may be corrupt at this point and
should be deleted.  Users should not attempt to paste blocks with SER instructions into VersaMax folders.

30. WIN98-Print Preview Page breaks do not match actual printouts.

31. Print Range for “Rung Range” does not work.

When printing logic from the LD Editor, the Range settings of From Rung and To Rung have no effect.  Regardless of
their setting, all rungs of logic are printed.

32. The second Ctrl-Alt-T in an SFC block causes an error.

If Ctrl-Alt-T is executed twice in an SFC block with the Delete Cross References check box checked, errors pertaining
to undeclared variables may be reported.

33. Store not triggered after changing constants in logic.

One specific case has been found that when constants are changed a store is not triggered.  Please refer to the GE
Fanuc Knowledge Base for a description of the topology.

34. Copy/Paste between Control and Access/Excel does not work.

When copying and pasting between Control and either Access or Excel, you may notice that Column I (corresponding
to the Retentive state) does not work.  If you encounter this, use SNF Import/Export to share the variables between
Control and Access or Excel.
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35. Toggle/Override sometimes does not work where is it allowed and sometimes works where it is not allowed.

Toggle/override is not allowed for transitional contacts and coils even though these instructions support it.

Toggle/override is allowed for fault contacts (FLT, NOFLT, HIALR, LOALR) even though selecting Toggle/Override
for these instructions has no effect.

36. Compiler can give Stored Value conflicts even when one is not present.

If overlapping variables with stored values are defined, a stored value conflict may be given by the compiler even if the
actual reference addresses of the overlapping variables have the same stored value.

37. Illegal PID values not handled properly on entry.

When an out of range value is entered in the PID dialog for either the “Sample Period”, “Proportional”, “Derivative”,
or “Integral” field, you correctly receive an error message indicating the data is invalid when you change focus to
another field.  Once the error message is acknowledged, you are not forced to stay in the field in order to correct the
value.  However, the invalid data is not saved to disk or written to the PLC.

38. %S bits are allowed on the output of a PSB call.

The editor allows you to place a variable with a %S memory type on the output of a PSB call.  As a result, if you make
use of this behavior, you could change the value of read-only memory in the PLC (such as ALW_ON).

39. Cast of an INT variable to a variable of BOOL with length 16 is not possible.

If you create a PSB with a parameter declared to have a type of BOOL and a length of 16, you will have to type cast by
hand if you choose to call the PSB with a variable of type INT.  When making the call, you will need to enter
“(BOOL[16] <var_name>)” on the operand.  If you enter simply the variable name, the system dialog that asks you
type cast the variable will not behave correctly.

40. Ctrl-X of a block in the browser, quickly followed by an "enter" removes block and corrupts folders.

Open a folder and highlight a block in the browser.  Press Ctrl-X (cut) quickly followed by Enter. (Be sure to take your
finger off the Ctrl key when Enter is pressed.)  The block opens, but it is empty.  Close block and refresh the browser.
A “null" icon appears with the block that was cut.  The block cannot be pasted back in.  If you try to open the block all
of its logic is gone.

Variables

1. Error message during Auto-Variable Location.

When an error occurs using auto-variable locate, the error message is general. The conditions are that the configured
references have been exceeded or that the range for auto-variable location has been exceeded. To view the range used
for auto-variable location, expand the Browser until the Resource is displaying in the left side of the Browser window,
then double-click Resource to open the Resource Editor. From within the Resource Editor window, select Program
from the Control menu and choose Auto Variable Locate.

2. Selecting multiple items in Variable Declaration editor.

You must use the keyboard to select multiple variables in the editor.

3. Deleting variables at the Local Scope.

If the same variable name exists at Local and Config scopes and the local scope one is used, the Config Scope one can
not be deleted from the Block Editor window. You can, however, open the Config Scope editor and delete the variable
name from there.

4. Descriptions of Variables do not wrap in a consistent manor when displayed in LD Editor.

The wrapping of long descriptions is based strictly on the default wrapping supplied by the Windows underlying
controls.  The convention used in LM90 is not observed.

5. All stored values after a blank stored value in a structure are lost.
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In order to avoid this problem, the user must enter explicit stored values for all fields preceding any field for which an
explicit stored value is desired.

6. AVL fails to byte align %M reference.

The starting address for the Bit Sequencer must be byte aligned.  AVL does not take this into account when it assigns
the %M reference.  On compile AVL assigns an address that is not byte aligned and then you get an error telling you
that the memory address is not aligned. An Address needs to be entered properly byte aligned instead of using AVL.

7. REAL variable's stored value cannot be entered without decimal point and tenths digit.

Integer values are not accepted for Stored values for variables with a type of REAL. Workaround is to enter the
decimal point and a 0 in the tenths position

8. Search and replace of Variable reports error with no explanation.

If the replace string is the same as another variable at a different scope, the Search and Replace has an error with no
explanation. Workaround is to Search for the replace string to find the usage of the variable.

9. Copy paste of logic causes, Non retentive variables to change to Retentive after paste.

Retentive is the default choice for new variables. The paste process causes new variables to be created and they receive
the default retentive state. Workaround – check retentive state of variable and correct them after pasting logic.

10. Purge variables affects variables marked as "show external" used by HMI.

Variables marked "show external" are often intended for use by the HMI and include inputs or outputs that are not
used in the PLC program.  The Purge variable operation deletes these variables which could  cause a possible loss of
the link in the HMI.

11. Vardec: Sort by description does not function properly after changing descriptions.

Create variables all without descriptions, Click the Description column header (causes sorting by description).  Go to
the first variable and type, for example "ccc" as the description.  Notice that the variable goes to the end of the list.

Go to the top (the new first variable) and type "aaa" as the description and notice that the variable goes to the end of
the list.  Go to the top (the new first variable) variable and type "bbb" as the description and notice that the variable
goes to the end of the list and so forth.  The variable always go to the end of the list independent of it’s name.
Workaround is sort twice when sorting by description.

12. Variable declaration editor: Setting OVR while sorting by description, causes the variable to the end of the
list.

In variable declaration editor, create several variables  and set sorting to be by description.  Set OVR attribute by
striking the “Insert” key and click on the first variable.  The variable will go to the bottom of the list. Workaround is to
sort twice when sorting by description.

13. Watch Window does not auto refresh when a variable’s address changes.

Once a variable is placed into the Watch Window, Control does not update the variable’s attributes when they change.
Thus, if the address of a variable is modified (either through an edit or auto-location), it must be deleted from the
watch window and then added again.

14. Contents of Watch Window are destroyed when trying to open a non-existent file.

If an attempt is made to open a .wwf file which does not exist, the contents of the existing Watch Window will be
deleted.  This occurs because the Watch Window was cleared out in order to add the variables that would have come
from the .wwf file.

15. Watch Window does not use Password Levels.

If the Watch Window connects to a PLC with password levels set, no operations from the Data and Override menus
will work.

16. Watch Window data entry problem for INTs in binary or hex mode.
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Binary display of INTs will only allow 15 bits of data to be entered.  There is a related problem where in HEX mode,
the first bit cannot be set.  So, 16#7fff is accepted but 16#effff is not.  (Note:  for WORD variables, 16#efff is
accepted.)

17. Named Alias variables do not inherit stored values.

When a variable’s address is defined in terms of another variable (that is, a Named Alias), the defined variable does
not inherit to base variable’s stored value.

18. No error message box is displayed when “Copy Online Value” is performed on Named Alias variables.

If you select a variable whose address is specified in terms of another variable (that is, a Named Alias), you can change
the Online Value of the variable’s address, but the “Copy Online Value” function will not update the variable’s Stored
Value with its current Online Value.  Not only does the operation not occur, but no error message is displayed.

19. Existing variables are not cleared when loading to TEMP.

If a TEMP folder is created from another folder using the Save As operation, when a load from the PLC to TEMP is
performed the variables that existed in the folder prior to the load will not be cleared.  To avoid this problem, delete
the TEMP folder and create a new TEMP folder before loading from the PLC.

20. Named alias variables defined by Auto-Variable Locate have their addresses put into SNF files.

When you export all variables with the “Resolve Named Alias Addresses” checkbox checked, the named alias
variables in the SNF created should have blank addresses.  Instead, they have address which correspond to the
defining variable.

21. Titles of Variable Tables are incorrect when printed from the Variable Editor.

If you print Variable Tables for multiple blocks from the Variable Editor, you will notice that all tables printed have
the same block name in the title.  In order to avoid this problem, print the Variable Tables from the Ladder Diagram
Editor.

22. Precision differences for REAL variables in Ref Tables versus Watch Window.

If you enter an online value for a REAL variable that contains 7 or more decimal points, only the first 6 are taken into
account when the variable's display format is changed to BINARY or HEX in the Watch Window.  For example,
1.23456789E10 is displayed as 1.234567E10 in the Watch Window and the binary and hex forms represent this
displayed value.  In the reference tables, 1.23456789E10 is used for the BINARY and HEX displays.  Thus, the two
monitors systems show different values for the same number.

Redundancy

1. Genius Output transfer check not performed.

CPU redundancy is supposed to check that all Genius outputs and being transferred and warn if they are not. This
check is not done. The check needs to be done manually.

2. Fatal System Error closing objects in browser.

In Dual Bus/ External mode if an object is inserted in the browser, changing views or closing the object causes a Fatal
System Error.

3. Equality not displayed correctly with CPU Redundancy.

When using CPU redundancy in “Single View” mode, even though both CPUs are configured identically, only the
view of the Hardware configuration for the CPU to which one is attached will show equal.  If the programmer is
attached to the Primary CPU then the view of the Secondary configuration will show “NOT EQUAL” and visa versa.

4. Genius Bus must be expanded before proper configuration can be created for Redundant Controller and
Dual Bus.

After a GBC has been created, the bus must be expanded at least once, even if there are no blocks to be configured in
order for the redundant Bus Controllers to be properly configured.
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Install

1. Copy Protection/NT CHKDSK conflict.

Control uses a version of CrypKey Software Licensing System.  Once installed, this software prevents NT's CHKDSK
tool from checking the drive during startup.  The user will get the error message:

Checking File System on C:

The type of the file system is NTFS (or FAT)

Can not open the volume for direct access.

Microsoft references this problem in Knowledge Base article, Q176504.  They recommend disabling the NetworkX
device (used by CrypKey) in the control panel and restarting the system.  Only then can CHKDSK be used on the Boot
partition.  Before using Control again, the NetworkX device needs to be re-enabled.

2. Converting the file system from FAT to NTFS causes Control to lose its license.

If you install and authorize Control on a FAT file system and then convert your system to NTFS, you will have to
reauthorize Control.

Event Manager

Event Manager can go into an infinite loop.

The event manager can go into an infinite loop if a control event launches the event manager client.


